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ADO Reports

SECTION 1

ADO Reports

Report generation and performance have been improved with Vitalware 3.0 and it
is now possible to report directly to an Open Database Connectivity (ODBC) data
source and to an ActiveX Data Objects (ADO) RecordSet object, bypassing the ODBC
filtering process.

The new report options are:

e Crystal Reports: report directly in ODBC format, bypassing the ODBC filtering
process.

e Crystal ADO: report using ADO RecordSets for Crystal (which are accessible via
Crystal's ADO connector).

e Microsoft ADO: report using ADO RecordSets for Microsoft products.

6 Crystal and Microsoft reports (Excel, Power Point and Word) which
currently connect to an ODBC data source can be modified to use an
ADO RecordSet.
[t remains possible to create reports by connecting directly to an ODBC
data source.

Note

This document assumes familiarity with Report creation in Vitalware. Full details
about Report Creation are available in the Vitalware Help: Working with Vitalware
records>Reports.
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Crystal Reports

SECTION 2

Crystal Reports

Creating a Crystal Report using the new ADO RecordSet is similar to creating a
Crystal report with a direct ODBC connection. The main differences are in selecting
the data source. This document describes the differences.

How to create a Crystal ADO Report

In Vitalware:

1. Search for or otherwise list a group of records on which to report.

@ When designing a Crystal ADO report the records in your initial record
set must have a value in each field to be included in the report. If not,
the field name will not appear in the list of available columns. Once the
report is defined, it does not matter if a record does not have values in
every field included in the report.

2. Click Reports = in the Tool bar to display the Reports box.
3. Click New in the Reports box.
The Report Properties box displays.
4. Enter a descriptive name for the Report in the top text field.
5. Select Crystal ADO Report from the Type drop list:
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Crystal Reports

Report Type | Fields | Sort Order | Options | Securty |

IPus Report

Type: |Crystal ADO Report
IAII Languages
I™ Use Display Order

6. On the Fields tab, add the fields to be included in the report.
In this example the fields selected are:

4 Wtalware. ADO Reports
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Crystal Reports

Report Type Fields | Sort Order | Options | Securty |

&%|§}_: BaGa| ¢ &
= 1”RN

[= Insertion Date: (Insertion Details)
[= Inserted By: (Insertion Details)
[= Pending Refund
[=] Primary Status: (Record Status)
= [E SalOrdersRef_tab
[=] Name: (Applicant Details)
[=] Address: (Applicant Details)
[=] Postal Code: (Applicant Details)

E B

7. Make changes on the other tabs as required.

See the Vitalware Help for details about setting a sort order, sort options, and
security.

8. Click OK.
The new report is added to the Reports box.

9. Inthe Reports box, select the new report and click to run the report for the first
time.
A message will display indicating that your report does not exist on the server.
This is to be expected as the report has not yet been built in Crystal Reports:

KE Vitalware
A report file has not been specified.
Do you want to start a new report ?

O

10. Click Yes.

An xml file is generated and saved with the data from your record set. The
location of this file can vary, but typically it can be found in:

C:\Users\[your
username]\AppData\Local\KESoftware\Reports\e[module name]

For example, a report run in the Parties module, will save the xmldata file to:
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Crystal Reports

11.

12.

C:\Users\[your
username]\AppData\Local\KESoftware\Reports\eparties

The Crystal Reports Designer application will open.

On the Start Page of the Crystal Reports Designer, select Blank Report under
the New Reports heading

-OR-
Select File>New>Blank Report in the Menu bar.
The Database Expert box displays:

Data

Browse the data source for the tables you want to add.
(Note: to edit the alias for a table, select the table in the "Selected Tables'tree and click on it or

press the F2 key)

Available Data Sources: Selected Tables:
]

- Favorites

f-(C] History

i1 (Z]Create New Connection
#1-(Z] Repository

Cancel | | _Heb
Double-click Create New Connection and click * beside ADO.NET (XML):

Vitalware' ADO Reports
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Crystal Reports

Data
Browse the data source for the tables you want to add.
(Note: to edt the alias for a table, select the table in the 'Selected Tables'tree and click on it or
press the F2 key)
Available Data Sources: Selected Tables:
& (3 Cument Connections
(- (C] Favorites
@ History
(L Create New Connection
- (£ Access/Excel (DAD)
®
- (3 Database Fies
(- (] Exchange 5.5 Message Tracking Log
[#- (L) Exchange Message Tracking Log
(- (3 Legacy Exchange
(- (1 Mailbox Admin
-C10DBC (RDO)
- (30kp
- CIOLE DB (ADO)
[#- (L] Outlook /Exchange
(Z3 Public Folder ACL
- [ Public Folder Admin
- (C Public Folder Replica
- (3 Universes
SaxmL
(- ) More Data Sources
- (] Repository

The following screen will display:

ADO Reports \fitalware& !
»M\A



Crystal Reports

Connection
Please erter connection information...

File Path :

Use Classes from Project: [l

Liass MName

Use DataSet from Class: m

13. Click the button beside the File Path field to locate and select the xmldata.xml
file created when the report was first run (Step 9).

See Step 10 for details of the location of the xmldata.xml file.
14. Click Finish to return to the Database Expert:
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Crystal Reports

—

press the F2 key)
Available Data Sources:

Browse the data source for the tables you want to add.
(Note: to edt the alias for a table, select the table in the "Selected Tables' tree and click on it or

Selected Tables:

& (A Curent Connections

- (I Favortes

- (C] History

- (LCreate New Connection
() Access/Excel (DAO)
B

i %3 Make New Connection

i ~~ &) Schema

@-(Legacy Exchange
(- CMailbox Admin
-(CJ0DBC (RDO)
®-(0ip

(#-(CJOLE DB (ADO)

#-(Z] Outlook /Exchange
(- () Public Folder ACL
- (Z) Public Folder Admin
(#-(_]Public Folder Replica
(- Universes
@-CXML

(#-[Z1 More Data Sources
- (CJRepository

(#-(C)Exchange 5.5 Message Tracking Log
#-(()Exchange Message Tracking Log

0K Cancel |

Help

Field values from the POS module are contained in the table called row.
15. Select row and add it to the Selected Tables pane:

[ Das |

Browse the data source for the tables you want to add.
(Note: to edt the alias for a table, select the table in the "Selected Tables'tree and click on it or

= (C2Create New Connection

G- () Access/Excel (DAD)
=-[C2ADO.NET (XML)
-3 Make New Connection
BBl

(- (L] Exchange 5.5 Message Tracking Log
[#- ) Exchange Message Tracking Log
- Legacy Exchange

-1 Maibox Admin

(-(C30DBC (RDO)

- (30t=p

-(CJOLE DB (ADO)

(#1-[£]Outlook /Exchange

(3 Public Folder ACL

(#)-(Z Public Folder Admin

1- (] Public Folder Replica

(- Universes

- XML

(#-(Z More Data Sources

- (L] Repository

press the F2 key)

Available Data Sources: Selected Tables:
®- (3 Current Connections & @ ol
- (X Favorites L@ row
(- (L] History

ADO Reports
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Crystal Reports

16. Click OK.

The Crystal Report Designer displays, ready for you to design your Crystal
report. See the Vitalware Help for details of designing a Crystal Report.

0 It is important not to move the xmldata.xml file as this will cause
problems when sharing the report with other users.
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Crystal Reports

How to modify a Crystal Report to use
ADO instead of ODBC

To modify a Crystal Report to use ADO rather than ODBC:

1. Open the Report Properties dialogue for the report.
2. Select Crystal ADO Report from the Type drop list:

Report Type | Fields | Sort Order | Options | Securty |
[
|'u

Type: |Crystal ADO Report

Language: IAII Languages
r Uze D .'|_'|'.'|.', Urager

The fields for this report are:

ADO Reports Vitalwaré
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Crystal Reports

Report Type Fields | Sott Order | Options | Securty |

e

IR

= IRN

[=] Pending Refund

[=] Primary Status: (Record Status)

B [E SalOrdersRef_tab

[=] Name: (Applicant Details)
[=] Address: (Applicant Details)
[=] Postal Code: (Applicant Details)
El Summary Data
g
(=] Price: (Product Details)
[=] Quantity: (Product Details)
(=] Sub-Total: (Product Details)

 OK % Concel | 2 Hep

Two tables are generated in this report.
3. C(Click OK and run the report.
Crystal will create the ADO record set and the following error will display:

@ The table 'epos_csv' could not be found.

4. Open the Crystal report in the Crystal Report Designer and select the
Database>Set Datasource Location menu option.

The Set Datasource Location dialogue will display:

12 Wtalware." ADO Reports
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Crystal Reports

Change the location of the data source by selecting the cument database (ortable) and choosing the database (ortable) to
replace it with. Then click Update.

Current Data Source:

= ] report
E| g <1 KE Vitalware Pos
. & Properties
- - Eepos_csv
- Ea Subreports
-3 KE Vitalware Pos

Replace with:

(#- [ Cument Connections
#- (L] Favorites

(- ([ History

(#- [Create New Connection
&+ () Repostory

5. Select Create New Connection in the Replace with pane and click * beside
ADO.NET (XML).

The following screen will display:

ADO Reports \fitalwareen 13
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Crystal Reports

Connection
Please enter connection information...

File Path :

Use Classes from Project: M

Use DataSet from Class: ]

6. Click the button beside the File Path field to locate and select the xmldata.xml
file created when the report was run.

The location of this file can vary, but typically it can be found in:
C:\Users\[your
username]\AppData\Local\KESoftware\Reports\e[module name]
For example, a report run in the Parties module, will save the xmldata file to:
C:\Users\[your
username]\AppData\Local\KESoftware\Reports\eparties

7. Click Finish.
You are returned to the Set Datasource Location dialogue:

. \ﬁtalware?\ ADO Reports
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Crystal Reports

Change the location of the data source by selecting the cument database (or table) and choosing the database (or table) to
replace it with. Then click Update.

Current Data Source:
= [ repor
=135 KE Vitalware Pos
| - Properties
i £p0s_csv
= @8 Subreports
[+ 1% KE Vitalware Pos

Replace with:

= Create New Connection ~ Update
[ () Access/Excel (DAD)
.}~ Make New Connection

LB Sml

data
datatype
[EE BlementType
[ extends
ow
[@ SalOrdersRef_tab
i Schema
[#-[Z1 Database Files
[#-[_ Exchange 5.5 Message Tracking Log
[#-[Z) Exchange Message Tracking Log
& (Legacy Exchange
(#1- (] Mailbax Admin
@ (Z10DBC (RDO)

[l i T 108

Next it is necessary to map fields from the old ODBC data source to the new ADO
RecordSet.

In this example there are two tables to map and one sub-report.

8. To map the old ODBC POS fields to the new POS table, click epos_csv in the
Current Data Source pane and then click the row table in the Replace with pane.

The Update button will be enabled.
9. Click the Update button and the Map Fields dialogue will display:

ADO Reports Vitalware’h 15
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Crystal Reports

@ SalRefundPending
w_kﬂ'

Map

[w] Match type

Fields with the same name will be mapped automatically.

10. Uncheck the Match type check box to reveal more fields in the Unmapped Fields

pane:

16
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Crystal Reports

".@= SalRefundPending

11. Complete mapping fields in the Unmapped Fields pane.

In this example we map epos_key to epos_key and irn to irn by selecting
both fields to map and clicking the Map button.

Once mapped, fields will be moved to the Mapped Fields pane:

ADO Reports Vita|ware°h 17
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Crystal Reports

Unmapped Fields

(=& Report Fields
=)-[E] epos_csv
" &= SalRefundPending

Mapped Fields

=@ Report Fields
EJ"' epos_csv
&= Primary Status

Loam

12. Click OK when all fields are mapped.
You are returned to the Set Datasource Location dialogue.

13. Repeat the mapping process for all fields (in this example, mapping fields in the
SalOrder_csv table to the ADO table SalOrdersRef_tab):

18 Wtalware." ADO Reports
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Crystal Reports

Change the location of the data source by selecting the cument database (or table) and choosing the database (ortable) to
replace it with. Then click Update.

Current Data Source:

B% KE Vitalware Pos
Eg Properties
-] SalOrder_csv

Replace with:

(= [_JCreate New Connection

i B[ Access/Excel (DAQ)

i =-(JADO.NET (XML)

: 1 -3 Make New Connection

[-Jﬁ,;xmi

Adtribute Type
- [E8 data
[ datatype
- [B8] Blement Type
- [E] extends
B row
. [E%) Schema
[#-()Database Files
E+I () Exchange 5.5 Message Tracking Log
| @[ Exchange Message Tracking Log
| @ (Legacy Bxchange
- (LA Mailbox Admin
i (ZJODBC (RDO)

N s o

14. Once all fields have been remapped in all tables click Close.
You are returned to the Crystal design window.

If you refresh report data at this stage and you have a sub-report object, you will
probably receive an error regarding sub-report links, e.g.:

ADO Reports \/italwareen 19
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Crystal Reports

m A string is required here,

Click OK to open the Record Selection Formula Editor. Change the link key field
used by the old ODBC table to the link key field referenced by the ADO
RecordSet:

‘ B Saveand close [ Save H | "[Q |~ 2

|20 o B M4 % % % | B[R] o s

| X |% B8 |& & |

vl # ‘

—_————————————i ¥

-2 Emor :A string is required here.
- ¥4 Record Selection

¥ Report Custom Functions

i+ ¥ Repository Custom Functions

+-{_] Formula Fields

i-{Z) Selection Formuias

8- Formatting Formulas

x
A

&= Sal0rder_csv. AppName

i SalOrder_csv.AppAddress
—m= SalOrder_csv AppPostalCode
~-m= Sal0rder_csv.SummaryData
= SalOrder_csv OrdProduct

i SalOrder_csv OrdPrice
== 5al0rder_csv OrdQuantity

b SalOrder_csv epos_key
~[?] Pm-epos_csv epos_key

| =@ xml (ADO.NET (XML))

(Salordexmcsv - Saloxdezsner_key) o lsalorder_csv - epas_lcey)

~

v

ﬁ - (i Functions

The report should now work correctly.

20
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Microsoft Excel

SECTION 3

Microsoft Excel

0 The following examples demonstrate how to create a basic Excel
report using VBA. Please note that it is not the intention of this
document to teach VBA.

Excel 2013 was used to create these reports.

How to create an Excel Report using the
ADO RecordSet

With ODBC data sources there is an option in Excel to open a connection without
writing Visual Basic code. This is not the case when making a connection to an ADO
record set and it is necessary to write VB code.
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Microsoft Excel

Step 1: Create a new report in Vitalware

This first example is a simple report on single value fields from the POS module. The
VBA code provided in this example will automatically populate headings and row
data for each column selected.

In Vitalware:

1. Search for or otherwise list a group of records on which to report.

2. Click Reports = in the Tool bar to display the Reports box.
3. Click New in the Reports box.
The Report Properties box displays.
4. Enter a descriptive name for the Report in the top text field.
5. Select Microsoft ADO Report from the Type drop list:

Repott Type | Fields | Sort Order | Options | Securty |

i e

Type: | Microsoft ADO Report

Language: IAII Languages
[” Use Display Order

6. On the Fields tab add the fields to be included in the report.
Fields selected in this example are:

22 \ﬁtalware?\ ADO Reports
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Microsoft Excel

Report Type Fields | Sort Order | Options | Securty |

&%|§}_: BaGa| ¢ &
= 1”RN

=] Primary Status: (Record Status)

E] Summary Data

[=] Total/Total: (Balances Given)

[=] Received/Received: (Payments Taken)

Ef 6aance Esances Gven)

7. Make changes on the other tabs as required.

See the Vitalware Help for details about setting a sort order, sort options, and
security.

8. Click OK.
The new report is added to the Reports dialogue box.
9. Select the new report and click Report All to run the report for the first time.

A message will display indicating that your report does not exist on the server.
This is to be expected as the report has not yet been built in Excel:

KE Vitalware

|i A report file has not been specified.
Do you want to start a new report?

10. Click Yes.

An xml file is generated and saved with the data from your record set. The
location of this file can vary, but typically it can be found in:

C:\Users\[your
username]\AppData\Local\KESoftware\Reports\e[module name]

For example, a report run in the Parties module, will save the xmldata file to:

C:\Users\[your
username]\AppData\Local\KESoftware\Reports\eparties

ADO Reports Vitalware’h 23
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Microsoft Excel

Microsoft Excel will open with a blank worksheet as follows:

m H % ” g Book1 - Excel e T . L
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER George Calderara =

General v _r|xl [ | ) £57 ineen = E' %'T H

- A& dxpelete v [#] "
§-9% » @ m Conditional Formatas Cell .. Sort & Find &
o o0 +.0 %] Format- & -
Formatting ~ Table = Styles~ = —  Filter - Select ~
Clipboard = Font w Alignment w Mumber = Styles Cells Editing ~

Sheet1 ® al >

100%

e Vitalware&’ \ ADO Reports
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Microsoft Excel

Ensure that Excel is setup correctly

If the Developer tab does not display in the Ribbon:

1. Click File>Options>Customize Ribbon.

2. With Main Tabs selected from the Customize the Ribbon drop list (1), select the
Developer check box (2):

Customize the Ribbon:

.Main Tabs

= v Home
# Chpboard
* Font
* Alignment
# Number
* Styles
® Cells
[ Editing

® [V Insert

@ [V Page Layout

# |V Formulas

v Data

v Review,

Vi

v loper

v Add-Ins

¥ Background Removal

EEEEBE®

[=]

In order to run the macros that we will create with our reports, we need to ensure
that the Security level in Excel is appropriate:

1. On the Developer tab, click [ Macro Security

2. Enable all macros:

ADO Reports

Vitalware

ital Reconds Management
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Microsoft Excel

Trusted Publishers

Trusted Locations
Trusted Documents
Trusted App Catalogs
Add-ins

ActiveX Settings

Protected View
Message Bar
External Content
File Block Settings

Privacy Options

Macro Settings

(0) Disable all macros without notification
() Disable all macros with notification

() Disable all macros except digitally signed macros

(®) Enable all macros (not recor

Developer Macro Settings

["] Trust access to the VBA project object model

d; potentially d

g

us code can run)

Cancel

3. Click OK to close the Trust Center.

4. On the Developer tab, click

,

/e

Visual
Basic

The following screen displays:

26
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Microsoft Excel

Ble ot View lnsent Fgmal Debug Bun ook Addm Window Help
B9 0 s ENEF @

5. Ensure that the Microsoft ActiveX Data Objects Library is available:
5.1. Select Tools>References in the Menu bar

In the References - VBAProject dialogue that displays, make sure that the
following checkbox is checked:

Available References:

[ | Microsoft Actions 2.0 Type Library

[ Microsoft ActiveMovie Control

[ Microsoft ActiveX Data Objects (Multi-dimensional) :
[ | Microsoft ActiveX Data Objects (Multi-dimensional) 1
[[] Microsoft ActiveX Data Objects 2.0 Library

[[] Microsoft ActiveX Data Objects 2.1 Library

[ ] Microsoft ActiveX Data Objects 2.5 Library

[ | Microsoft ActiveX Data Objects 2.6 Library

[ | Microsoft ActiveX Data Objects 2.7 Library

[ ] Microsoft ActiveX Data Objects 2.8 Libra

Microsoft ActiveX Data Objects 6.1 Library

[ Microsoft ActiveX Data Objects Recordset 2.8 Librar
[[] Microsoft ActiveX Data Objects Recordset 6.0 Librar
[ | Microsoft Add-In Desianer v
< >

— Microsoft ActiveX Data Objects 6.1 Library

Location:  C:\Program Files (x86)\Common Files\System‘\ado\msadol5
Language: Standard

5.2. Click OK.

ADO Reports Vitalware 27
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Microsoft Excel

Step 2: Design the report in Excel

1. Double-click Sheet1 in the VBAProject pane:

'@ fle Edt View et Fomat Debug Bun Tooks Addns Window Help
H&-d » na K HFY 4@

Project - VBAProject x| [(Generan _»| |(Dectarations)

o3& B

= &% VBAProject (Book1)
23 Mosoft Excel Objects

E ThaiWorkbook

X
=

Sheetl Worksheet

Aphabetc |wa
s
DisplayPageBreaks  False
DisplayfightToleft  False
AutoFilter Falze
True

2. Copy and paste the following VB code:

Sub OpenAdoFile()
Dim RecordSet As ADODB.RecordSet
Dim Worksheet As Excel .Worksheet
Dim h As Long
Dim col As Long
Dim datarow As Long
Dim source As String

" Get the persisted record set

source = Environ(*'LocalAppData'™) & "\KESoftware\
Reports\epos\xmldata.xml"

Set RecordSet = New ADODB.RecordSet
RecordSet._Open source, "Provider=MSPersist"

" Get the active page to send the data to
Set Worksheet = ThisWorkbook.ActiveSheet

Application._Visible = True

" Put out all of the column headers
col =1

28 Vitalware&’ \ ADO Reports
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Microsoft Excel

ListColumnNames Worksheet, RecordSet, col

" Print out all the row data
While Not RecordSet.EOF
col =1
datarow = datarow + 1
For h = 0 To RecordSet.Fields.count - 1

Worksheet._Cells(datarow + 1, col).vValue =
RecordSet._Fields(h) .Vvalue

col = col + 1
Next
RecordSet.MoveNext
Wend

Worksheet.Range("'A1') .CurrentRegion.Select
Worksheet.Columns._.AutoFit
Set RecordSet = Nothing

End Sub

Private Sub ListColumnNames(ByVal ws As Excel .Worksheet, ByVal
rs As ADODB.RecordSet, ByRef col As Long)

Dim i As Long
" Loop through the record set pulling out the column names
For i = 0 To rs.Fields.count - 1
ws.Cells(l, col).Value = rs.Fields(i).Name
col = col +1
Next
End Sub

ADO Reports Vita|ware“A 29
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Microsoft Excel

sual Basic fo ’ x
@) Ble | fdt View Juet Format Debug Bun Tooks Addns Window Help .8 x
HE-J +» @920 » 0 akd §FY @ nisco9 l

ct - VBAProject x| [(Generai) ] |ListColumniames =l

l Sub OpenAdoFile() =)
45 VBAProject (Bookl) Dim RecordSet As ADCDB.RecordSet ml
B &5 Mcosoft Excel Objects Dim Worksheet As Excel.Worksheet
Sheet] (Sheetl) Dim h As Long
ThisWerkbook Dim col As Long

Dim datarow As Long
Dim source As String

' Get the persisted record set

source = Environ("LocalAppData®™) & "\KESoftware\Reports\ecatalogue\xmldata.xml®
Set RecordSet = New ADODB.RecordSet

RecordSet.Open scurce, "Provider=MSPersist”®

' Ger the active page to send the data to
Set Worksheet = Thi JActi t
Application.Visible = True

* Put out all of the column headers
col = 1
LiscColumnNames Worksheet, RecordSet, col

i
Ll e

* Print out all the row data

w' While Not RecordSet.EOF
Sheetl col = 1
chePagetress  False datarow = datarow + 1
splayRightToleft  False For h = 0 To RecordSet.Fields.Count - 1
L False Worksheet.Cells(datazew + 1, col).Value = RecordSet.Fields(h).Value
oulato True col = col + 1
Conditon True: NHext
ke Faloe RecordSet.MoveNext
offable  Fakse Wend
0-
Sheetl Workaheet.Range ("Al") .CurrentRegion.Select
Worksheet.Columns.RuteFit
30 Set RecordSet = Hothing
e End Sub

Private Sub ListColumnMames (ByVal ws As Excel.Worksheet, ByVal rs As ADODB.RecordSer, ByRef col As Long)
Dim 1 As Long

* Locp through the record set pulling out the column names
For 1 = 0 To rs.Fields.Count - 1

ws.Cells(l, col).Value = ra.Fields(i).Name

col = col + 1

NHext
End Sub

3. Double-click ThisWorbook in the VBAProject pane and copy and paste the
following code:
Sub Workbook_Open(Q)
" Load up the ADO File
Sheetl.OpenAdoFile
End Sub

& File Edit View [nset Format Debug Run Tools Add-lns Window Help
HE&-d M ‘» na ST QO
Project - VBAProject [Workbook <] [open

Sub Workbook_Open ()
B 5 VBAProject (Book1) ' Load up the ADO File
=-£5 Mcrosoft Excel Objects Sheetl.OpenAdoFile
Sheet1 (Sheetl) End Sub

ThisWorkbook

30 Wtalware." ADO Reports
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Microsoft Excel

4. Save the report as macro enabled and upload it to your Vitalware report (page
22) on the Report Type tab of the Report Properties box.

When the report is run in Vitalware, an Excel report is generated:

POS11 - Excel

Sign in 53l m}

.. Tell me what you want to do (q_ Share

Insert Page Layout Formulas Data Review View Developer

=X ibri - e rl == »-.- S . E E=nsert - X - A p
! tD . Calibri 11 A A == E¢  General . E_:t—l . L_‘:“ %“ B Delete - | [3]- SZI_IL -~

aste v - - . .9 <o oo Conditional Formatas Cel = ] in

- SR o 2 2 $-% 0 WA Formatting - Table~ Styles~ b=l Format - " Filter - Select -
Clipboard & Font 1 Alignment I MNumber I Styles Cells Editing ~
19 - f
A . B C | D E F | G | H |

1 epos_key irn PrimaryStatus SummaryData PayTotal PayReceived PayBalance

2 | 1 29 Finalised [Cancelled] on 23/10/2015 11:11 VW Admin (1 products) 0 0 0

3] 2 28 Finalised [INCOMPLETE] on 15/10/2015 13:52 VW Admin (2 products) 55 55 0

4 | 3 35 Finalised [Cancelled] on 03/02/2016 15:31 VW Admin (1 products) 0 0 0

5 | 4 67 Finalised [Cancelled] on 05/02/2016 15:33 VW Admin (1 products) 0 0 0

6 | 5 72 Finalised [INCOMPLETE] on 05/02/2016 15:45 VW Admin (1 products) 43.5 43.5 0

7] 6 85 Finalised [Refunded] on 05/02/2016 16:25 VW Admin (2 products) 0 43.5 43.5

8 7 82 Finalised [Refunded] on 05/02/2016 15:59 VW Admin (2 products) 0 43.5 43.5

9 8 78 Finalised [Refunded] on 05/02/2016 15:54 VW Admin (2 products) 0 43.5 43.5
10 | 9 171 Finalised [INCOMPLETE] on 09/02/2016 14:30 VW Admin (1 products) 43.5 43.5 0
11 10 125 Finalised [Refunded] on 09/02/2016 14:27 VW Admin (2 products) 0 43.5 43.5
12 11 134 Finalised [Refunded] on 09/02/2016 14:30 VW Admin (2 products) 0 43.5 43.5
13 | 12 175 Finalised [COMPLETE] on 01/03/2016 23:29 VW Admin (1 products) 0 0 0
14_ 13 190 Finalised [INCOMPLETE] on 08/04/2016 16:13 VW Admin (1 products) 43.5 43.5 0
15 | 14 201 Finalised [Cancelled] on 08/04/2016 16:18 VW Admin (1 products) 0 0 0
16_ 15 207 Finalised [INCOMPLETE] on 08/04/2016 16:20 VW Admin (1 products) 43.5 43.5 0
17_ 16 209 Finalised [INCOMPLETE] on 08/04/2016 16:31 VW Admin (1 products) 43.5 43.5 0
18_ 17 215 Finalised [INCOMPLETE] on 11/04/2016 12:07 VW Admin (1 products) 43.5 43.5 0
19_ 18 10000 Finalised [INCOMPLETE] on 11/04/2016 12:20 VW Admin (1 products) 43.5 43.5 0
20_ 19 10001 Finalised [INCOMPLETE] on 11/04/2016 12:25 VW Admin (1 products) 43.5 43.5 0
21 | 20 10002 Finalised [INCOMPLETE] on 15/04/2016 13:30 VW Admin (3 products) 75.15 75.15 0
22| 21 10003 In Progress [Refunded] on 15/04/2016 13:55 VW Admin (6 products) 0 75.15 75.15
23 22 10004 Finalised [COMPLETE] on 15/04/2016 13:58 VW Admin (6 products) 0 75.15 75.15
24 23 10005 Finalised [INCOMPLETE] on 18/04/2016 10:20 VW Admin (8 products) 49,25 75.15 25.9
25 24 10030 Finalised [COMPLETE] on 09/05/2016 23:42 VW Admin (1 products) 20 20 0
26 25 10029 Finalised [COMPLETE] on 09/05/2016 23:41 VW Admin (2 products) 40 40 0
27 | 26 10031 Finalised [INCOMPLETE] on 09/05/2016 23:42 VW Admin (14 products) 439 439 0
28 27 10040 Finalised [Cancelled] on 24/05/2016 13:43 VW Admin (1 products) 0 0 0
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How to create an Excel Report with
nested tables using the ADO RecordSet

1. Repeat Stepl: Create a new report in Vitalware (page 22).
For this example, the following fields were selected. Note the two nested tables
- SalOrdersRef tab and IdentificationDetails:

Report Type Fields | Sort Order | Options | Securty |

FLIEEIEEIER !

E Date Received
[=] Record Status: (Record Status)
[=] Total/Total: (Balances Given)
[=] Received/Received: (Payments Taken)
= [E SalOrdersRef_tab
[=] Name: (Applicant Details)
[=] Address: (Applicant Details)
[=] Product: (Product Details)
E Quantity: (Product Details)
= S} IdentificationDetails
= Type: (identification Details)
(=] Reference: (identification Details)

Add... | Remove | Clear |

VOK | Xcancel | P Hep

=
Visual
2. InExcel, click L2 | on the Developers tab.
Double-click Sheet1 in the VBAProject pane:
4. Copy and paste the following VB code:

w

Sub Read XML_Data()

Dim rst As ADODB.Recordset

Dim Worksheet As Excel .Worksheet
Dim i As Long

Dim j As Long

Dim source As String

Dim datarow As Long
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Dim saverow As Long
Dim lastrow As Long
Dim col As Long

" The next declaration is a little odd. Its needed in cases
where the entire value

" of a nested table is blank. In these cases it Is necessary
to force a number of columns to be skipped when printing

" out field values. Oddly, as long as a nested table has
at least one value, then there is no issue.

" There i1s only a need to declare one variable for each
nested table.

" In this example there are only two nested tables so two
declarations are needed

" The value assigned to each variable will depend on the
number of fields iIn that nested table.

" In this example the Tfirst nested table 1is the
SalOrdersRef _tab, which has four Tfields, 1i.e. AppName,
AppAddress, OrdProduct and OrdQuantity

" and the second nested table, i.e ldentificationDetails,
has 2 fields, i.e. IdeldentificationType and
IdelndentificationReference

Dim Firstnestedtable As Long
Dim secondnestedtable As Long
Dim nestedtablecount As Long

firstnestedtable = 4
secondnestedtable = 2
nestedtablecount = 1

" Get the persisted record set

source = Environ(*'LocalAppData’™) &
"\KESoftware\Reports\epos\xmldata.xml"

Set rst = New ADODB.Recordset
rst.Open source, "Provider=MSPersist"

" Get the active page to send the data to
Set Worksheet = ThisWorkbook._ActiveSheet
Application_Visible = True

*Add column labels

Worksheet.Cells(1l, 1).Select

ActiveCell _EntireRow. Insert
Worksheet.Cells(1, 1).Value = ""Record No"
Worksheet.Cells(1, 2).Value = "IRN No"
Worksheet.Cells(1, 3).Value = "Date Rec*vd"
Worksheet.Cells(1, 4).Value = "'Status”
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Worksheet.Cells(1, 5).vValue = "Total"
Worksheet.Cells(1, 6).Value = "Paid"
Worksheet.Cells(1, 7).Value = "Applicant”
Worksheet.Cells(1, 8).Value = "Address"

Worksheet.Cells(1, 9).vValue = "Product”
Worksheet.Cells(1, 10).Value = "Qty"
Worksheet.Cells(1, 11).Value = "ldentification Type"
Worksheet.Cells(1, 12).Value = "Id Value"

col =1
" Start printing data from Row 3
datarow = 3
lastrow = datarow
While Not rst_EOF
col = 1

I datarow < lastrow Then
datarow = lastrow
End If

For j = 0 To rst.Fields.Count - 1
IT rst_Fields(J)-Type = adChapter Then
IT rst.Fields(J)-Value.BOF Then
Worksheet.Cells(datarow, col).Value = ""
IT nestedtablecount = 1 Then
col = col + Firstnestedtable

nestedtablecount = nestedtablecount +
1
Elself nestedtablecount = 2 Then
col = col + secondnestedtable
nestedtablecount = nestedtablecount +
1
End If
Else

IT rst.Fields(j)-.Value.EOF Then
Worksheet.Cells(datarow, col).Value

IT nestedtablecount = 1 Then
col = col + Firstnestedtable

nestedtablecount =
nestedtablecount + 1

Elself nestedtablecount = 2 Then
col = col + secondnestedtable

nestedtablecount =
nestedtablecount + 1

End IFf
Else
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saverow = datarow

ListNestedValues Worksheet,
rst.Fields(j).Vvalue, col, datarow, lastrow, saverow,
nestedtablecount

End IT
End IT
Else

IT IsNull(rst.Fields(j)-VvValue) Then
Worksheet._Cells(datarow, col).Value =

Else
Worksheet.Cells(datarow, col) .Value =
rst.Fields(j).Value
End IT
col = col + 1
End IT

Next

rst.MoveNext

datarow = datarow + 1

nestedtablecount = 1
Wend

"Closing the recordset.
rst.Close

"Release object from memory.
Worksheet.Range(*'A1") .CurrentRegion.Select

Worksheet.Columns.AutoFit
Set rst = Nothing

End Sub

Private Sub ListNestedValues(Byval ws As Excel.Worksheet,
ByvVal rs As ADODB.Recordset, ByRef col As Long, ByRef datarow
As Long, ByRef lastrow As Long, ByRef saverow As Long, ByRefF
nestedtablecount As Long)

Dim i As Long
Dim j As Long
Dim startrow As Long

" Loop through a nested table pulling out the row values
1=0
startrow = saverow
While Not rs.EOF
Max = 1
Jj = col
For i = 0 To rs.Fields.Count - 1
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* Don"t print key values
IT rs.Fields(i).Name <> "SalOrdersRef key" And

rs.Fields(i).Name <> "ldentificationDetails_key" And
rs.Fields(i) .Name <> "epos_key"
Then

IT IsNull(rs.Fields(i).Value) Then
ws.Cells(startrow + 1, j).Value = """

1=3+1
Else
IT rs_.Fields(i).Type = adChapter Then
ListNestedValues ws,
rs.Fields(i).Value, I datarow, lastrow, saverow,
nestedtablecount
datarow = startrow
Else
ws_Cells(startrow, J)-value =
rs_Fields(i).Value
1=1+1
End If
End IT
End IT
Next

rs.MoveNext
startrow = startrow + 1
Wend

IT (g > 0) Then
col = j
End If

If startrow > lastrow Then
lastrow = startrow
End If

nestedtablecount = nestedtablecount + 1
End Sub

5. Double-click ThisWorbook in the VBAProject pane and copy and paste the
following code:
Sub Workbook Open()
" Load up the ADO File
Sheetl.Read XML Data
End Sub

6. Save the report and upload it to your Vitalware report (page 22) on the Report
Type tab of the Report Properties box

When the report is run in Vitalware, an Excel report is generated:
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POS1.xItm - Excel Signin M@ o

Home Insert Pagelayout Formulas Data  Review View [SSIESEE O what yc 8 share

Om == T Record Macro ’ =] = - [\( [=) Properties ¥ Impart

— = [ Use Relative References ﬂ i+ m = & View Code 1) Expansion Packs xpar
Visual Macros Add- Excel COM  Insert Design Source .

Basic b Macro Security ins Add-insAdd-ins - Mode (3 RunDialog ko el

Code Add-ins Controls XML ~

Al - I Record No -
y A B (¥ D E F G H 1 J K L M -
1 [Record No IRN No |Date Rec'vd Status Total Paid li Address Product Qty Identification Type Id Value |

2

3 1 10304 15/04/2010 INCOMPLETE 49.25 49.25 Eddie The Eagle 14 Crescent Road Birth Certificate 1 Drivers Licence 1234

4 Eddie The Eagle 14 Crescent Road Express Post 1 Blue Card 928347

5| Australian Passport M896/16

6 2 10305 26/08/2014 COMPLETE 50 45 Tom Jones 193 Wales Road Death Certificate 1 Drivers Licence 238947

7 Passport 2349/87

8 3 10309 13/06/2011 COMPLETE 100 100 Peter Piper 763 Pickeled Avenue Marriage Certificate 2 Drivers Licence 689343

9 | 4 10765 25/11/2016 COMPLETE 200 200 Joan Harvey 116 Happy Lane Change of Name 1 Drivers Licence 748937
10 Passport 3024390
1 | 5 10323 21/01/2013 INCOMPLETE 170 160 Mary Smith 12 Agars Street Birth Certificate 1 Blue Card 123789

12 Mary Smith 12 Agars Street Death Certificate 1 Passport 7834/M/f11

13 Mary Smith 12 Agars Street Registered Relationship Certificate 1
14 | Mary Smith 12 Agars Street Express Post 1

15| 6 178234 29/03/2015 COMPLETE 50 50 limmy Bedfellow 77 Orange Parade = Commemorative Certificate 1 Drivers Licence 4789433

16 |

17
18

19|
20 |
21|
22
23|
24
25 |
26 |
27
28 | -
Sheet1 ) [ 3
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Registry entries

SECTION 4

Registry entries

The Type Registry entry indicates which export type to use for each report request.

The format of this Registry entry is;
System|Setting|Reports|Type|Crystal CSV]value

value isOor1:
0 Generates data in the existing format.

1 Generates data in the new Crystal ODBC format.

6 If this entry is not present, a value of 0 is assumed.

System|Setting|Reports|Type|Crystal ADO]value

value isOor2:
0 Generates data in the existing format.

2 Generates data in the new Crystal ADO record set.

@ If this entry is not present, a value of 0 is assumed.

System|Setting|Reports|Type|Microsoft ADO|value

where:

value isOor3:
0 Generates data in the existing format.

3 Generates data in the new Microsoft ADO format.

@ If this entry is not present, a value of O is assumed.
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